
Micro Focus® Visual COBOL® 2.1 Update 1
for ISVs

Release Notes



Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com
  

Copyright © Micro Focus 2009-2013. All rights reserved.

MICRO FOCUS, the Micro Focus logo and Visual COBOL are trademarks or registered
trademarks of Micro Focus IP Development Limited or its subsidiaries or affiliated
companies in the United States, United Kingdom and other countries.

All other marks are the property of their respective owners.

2013-03-28

ii



Contents

Micro Focus® Visual COBOL® 2.1 Update 1 for ISVs Release Notes ............7
System Requirements ........................................................................................8

System Requirements for Visual COBOL for Visual Studio ................................................ 8
Hardware Requirements .......................................................................................... 8
Operating Systems Supported ................................................................................. 8
Software Requirements ............................................................................................9

System Requirements for Visual COBOL for Eclipse (Windows) ..................................... 10
Hardware requirements ..........................................................................................10
Operating Systems Supported ............................................................................... 11
Software Requirements ..........................................................................................11

System Requirements for Visual COBOL for Eclipse (UNIX) ........................................... 11
Hardware Requirements ........................................................................................ 11
Operating Systems Supported ............................................................................... 12
Software Requirements ..........................................................................................12

System Requirements for Visual COBOL Development Hub ........................................... 13
Hardware Requirements ........................................................................................ 13
Operating Systems Supported ............................................................................... 13
Software Requirements ..........................................................................................13

System Requirements for COBOL Server for Windows ....................................................14
Hardware Requirements ........................................................................................ 14
Operating Systems Supported ............................................................................... 14
Software Requirements ..........................................................................................15

System Requirements for COBOL Server for UNIX ..........................................................16
Hardware Requirements ........................................................................................ 16
Operating Systems Supported ............................................................................... 16
Software Requirements ..........................................................................................16

Installation ........................................................................................................ 18
UNIX Installer Issues .........................................................................................................18
Installing Visual COBOL for Visual Studio ........................................................................ 18

Installation restrictions and requirements ...............................................................18
Downloading the Product ....................................................................................... 19
Installing Visual COBOL for Visual Studio ..............................................................19
Installing as an Upgrade .........................................................................................19
After Installing .........................................................................................................20
Repairing ................................................................................................................ 20
Uninstalling .............................................................................................................20

Installing Visual COBOL for Eclipse (Windows) ................................................................21
Installation restrictions and requirements ...............................................................21
Downloading the Product ....................................................................................... 21
Installing ................................................................................................................. 21
Installing into different Eclipse packages ............................................................... 22
After Installing .........................................................................................................23
Installing X Windows on Windows ..........................................................................23
Repairing ................................................................................................................ 23
Uninstalling .............................................................................................................23

Installing Visual COBOL for Eclipse (UNIX) ......................................................................24
Downloading the Product ....................................................................................... 24
Installing ................................................................................................................. 24
Installing as an Upgrade .........................................................................................26
Installing into different Eclipse packages ............................................................... 26
After Installing .........................................................................................................27

Contents | 3



Configuring the Environment for Developing RDBMS Applications on UNIX .........27
Repairing ................................................................................................................ 27
Uninstalling .............................................................................................................27

Installing Visual COBOL Development Hub ......................................................................28
Downloading the Product ....................................................................................... 28
Installing ................................................................................................................. 28
Installing as an Upgrade .........................................................................................29
Configuring the Environment for Developing RDBMS Applications on UNIX .........30
Configuring the Remote System Explorer Support ............................................... 30
Repairing ................................................................................................................ 31
Uninstalling .............................................................................................................31

Installing COBOL Server for Windows .............................................................................. 31
Installation Restrictions and Requirements ............................................................ 31
Downloading the Product ....................................................................................... 32
Installing ................................................................................................................. 32
Installing as an Upgrade .........................................................................................32
COBOL Server Installation Options ........................................................................33
After Installing .........................................................................................................34
Repairing ................................................................................................................ 34
Uninstalling .............................................................................................................34

Installing COBOL Server for UNIX .................................................................................... 34
Downloading the Product ....................................................................................... 34
Installing ................................................................................................................. 35
After Installing .........................................................................................................35
Installing as an Upgrade .........................................................................................36
Installing Silently .....................................................................................................36
Repairing ................................................................................................................ 36
Uninstalling .............................................................................................................37

Licensing Information ......................................................................................38
What's New ....................................................................................................... 40

New Features in Visual COBOL 2.1 Update 1 .................................................................. 40
Compiler Directives ................................................................................................ 40
DB2 ECM ............................................................................................................... 40
Debugging enhancements ..................................................................................... 40

Features Added in Visual COBOL 2.1 .............................................................................. 40
ACUCOBOL-GT Data Types in Managed Code .................................................... 40
ACUCOBOL-GT Library Routines in Managed Code ............................................ 40
Associating File Extensions With the COBOL Language .......................................41
Automatic Directives Detection and Setting ........................................................... 41
Compiler Directives ................................................................................................ 41
.int, .gnt and .lbr File Types Support ...................................................................... 41
Just-in-time debugging ........................................................................................... 41
JVM Class Library .................................................................................................. 42
Managed COBOL Enhancements ..........................................................................42
OpenESQL ............................................................................................................. 42
UNIX Platforms Support ......................................................................................... 43

Features Added in Visual COBOL 2.0 .............................................................................. 43
Automatic Directives Detection and Setting ........................................................... 43
Building Projects to Multiple Output Files ...............................................................43
COBOL Explorer View ............................................................................................43
COBOL File Search ................................................................................................45
Compiler Directives ................................................................................................ 46
Compiling Single Files ............................................................................................46
Enhancements to Developing Applications on a Remote Machine ........................46
Converting Net Express Projects ........................................................................... 46
Copybook Context ..................................................................................................47

4 | Contents



Debugging Enhancements ..................................................................................... 47
Eclipse 3.7 ..............................................................................................................48
JVM COBOL File Handler ...................................................................................... 49
Library Routines ..................................................................................................... 49
Managed COBOL Language Features ...................................................................49
Data Access ........................................................................................................... 49
Remote COBOL JVM Projects - Early Release ..................................................... 50
Run-Time Tunables ................................................................................................50
Samples ................................................................................................................. 50
Vision Data File Searching ..................................................................................... 50
XML Support .......................................................................................................... 51

Features Added in Visual COBOL 2010 R4 Update 2 ...................................................... 51
Documentation for the Dialog System AddPack .................................................... 51
New Platforms Support .......................................................................................... 51
OO COBOL Class Library Reference .....................................................................51
Net Express Project Import Wizard ........................................................................ 52
OpenESQL ............................................................................................................. 52

Features Added in Visual COBOL 2010 R4 ......................................................................52
ACUCOBOL-GT Compatibility ............................................................................... 52
COBOL for Java Virtual Machine (JVM) Support ................................................... 53
Creating Projects from Selected Files .................................................................... 53
Debugging Enhancements ..................................................................................... 54
Documentation ....................................................................................................... 54
Embedded HTML ................................................................................................... 54
Improved Usability ..................................................................................................54
Improvements to the Implements Smart Tag ......................................................... 54
Language Improvements ........................................................................................54
Large Projects Support ...........................................................................................54
New Compiler Directives ........................................................................................ 55
New Samples and Tutorial ..................................................................................... 55
Project Details Window .......................................................................................... 55
Project Properties Updates .................................................................................... 55
Renamed Color Preferences ..................................................................................55
Reporting of Linker Errors ...................................................................................... 55
RM/COBOL Compatibility .......................................................................................55
Smart Linkage ........................................................................................................ 56
WCF Services and Service References ................................................................. 56
XML Extensions ..................................................................................................... 56

Features Added in Visual COBOL 2010 R3 ......................................................................56
.NET COBOL Syntax Improvements ......................................................................56
Creating Projects from Existing Code .................................................................... 59
Add Existing COBOL Items Wizard ........................................................................60
Override Class Members Dialog ............................................................................ 61
Smart Tag for Implementing Interfaces .................................................................. 62
Snippet for Implements .......................................................................................... 62
Navigate To ............................................................................................................ 62
Find All References ................................................................................................ 63
Web Application Projects ....................................................................................... 63
Debugging .............................................................................................................. 64
Samples Browser ................................................................................................... 65
ACUCOBOL-GT Compatibility and RM/COBOL .................................................... 66
XML Support .......................................................................................................... 67

Features Added in Visual COBOL 2010 R2 ......................................................................67
File Handler ............................................................................................................ 67
Go To Procedure Division ...................................................................................... 67
OpenESQL Assistant ............................................................................................. 67

Contents | 5



Samples ................................................................................................................. 68
Snippets ................................................................................................................. 68
SQL Support ...........................................................................................................68
XML Parse/Generate ..............................................................................................68

Features Added in Visual COBOL 2010 R1 ......................................................................68
Visual Studio as the Core Integrated Development Environment .......................... 68
COBOL 2010 ..........................................................................................................69
COBOL Language Extensions ............................................................................... 69

Main Features of Visual COBOL 2.1 for Visual Studio 2012 .............................................69
Known Issues ................................................................................................... 71
Resolved Issues ............................................................................................... 75
Updates and SupportLine ................................................................................80

Further Information and Product Support ..........................................................................80
Information We Need ........................................................................................................ 80
Creating Debug Files ........................................................................................................ 81

Disclaimer ......................................................................................................... 82

6 | Contents



Micro Focus® Visual COBOL® 2.1 Update 1
for ISVs Release Notes

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using either Microsoft's Visual Studio 2010 or Visual Studio 2012 integrated
development environments. Visual COBOL supports the development and deployment of both
managed .NET and native code applications.

Note: The product is available in two variants - Visual COBOL for Visual Studio 2010 , and Visual
COBOL for Visual Studio 2012.

Visual COBOL for Visual Studio 2010 and Visual COBOL for Visual Studio 2012 each target a
different version of the COBOL run-time system - COBOL Server and COBOL Server 2012,
respectively.

Ensure that after you've edited the project in the preferred version of Visual Studio, you compile
your source code in that version of Visual COBOL which targets the version of the COBOL run-
time in which you want your applications to run.

For example, if you build your application using Visual COBOL for Visual Studio 2010 you cannot
deploy the target files to COBOL Server 2012; you must use COBOL Server.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Visual COBOL.
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System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

• 58MB for the Sentinel RMS license server
• 200MB for Micro Focus COBOL integration into Visual Studio

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The following platforms are supported:

32-bit Windows Platforms • Windows Server 2008 SP2
• Windows Vista
• Windows XP Professional SP3 or later
• Windows 7
• Windows 8

64-bit Windows Platforms • Windows Server 2008 SP2
• Windows Server 2008 R2
• Windows Vista
• Windows XP Professional SP2 or later
• Windows 7
• Windows 8

Citrix and Terminal Server • Windows Server 2008 SP2
• Windows Server 2008 R2
• Windows 7
• Windows 8
• Windows Server 2012

Note:

• Visual COBOL for Visual Studio 2012 is not supported on versions of Windows earlier than
Windows 7.
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Software Requirements
Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

If you choose to install using the full image, you need to install the following software beforehand:

• A full version of Microsoft Visual Studio 2010 or Microsoft Visual Studio 2012 (Premium, Professional,
or Ultimate), or the the respective version of the Microsoft Visual Studio Integrated Shell.

Note:

• Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If

you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

The following functionality, tools and features have additional requirements:

Visual Studio IDE

• Microsoft Windows SDK is required if you are using Visual Studio Shell. See the Microsoft Download
Center and search for Windows SDK.

• Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.
• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Visual Studio 2010 Service Pack 1 is required if you are using Visual COBOL for Visual Studio 2010

and Visual COBOL for Visual Studio 2012 on the same machine. If you are using the Web installer to
install the product, it downloads and installs Visual Studio 2010 Service Pack 1 automatically. If you do
not have Internet access, you need to download Visual Studio 2010 Service Pack 1 on a machine that
has Internet connection, and then copy the installer to your machine.

In addition, when building a native COBOL project that contains resources you must replace the
cvtres.exe in the bin and bin64 directories of your Visual COBOL installation with the version of
the file which gets installed with Visual Studio 2010 SP1. You can download Service Pack 1 for Visual
Studio 2010 from the Microsoft Download Center.

Java Compilation

• The Java Development Kit (JDK), version 1.6 (u27 or later) or version 1.7 (u05 or later), is required for
compiling Java. The JDK is downloadable from www.oracle.com. After installing the JDK, you must put
the tools.jar file for the JDK on your classpath, using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

System Requirements | 9
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SQL CLR Integration for Visual Studio 2012
The following software is required to use the SQL CLR integration feature, which is specifically for the
development and deployment of COBOL stored procedures under Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:

• Either of the following:

• Visual Studio Shell 2012 and Microsoft SQL Server Tools (SSDT SDK)
• Visual Studio Professional 2012, Premium 2012, or Ultimate 2012

• Any of the following:

• SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server 2012 targeting .NET CLR v4.0 framework (4.0), or .NET CLR v2.0 frameworks (2.0, 3.0,

3.5)
• SQL Server Azure targeting .NET CLR v4.0 framework (4.0) and also .NET CLR v2.0 frameworks

(2.0, 3.0, 3.5)

Important: The SQL CLR Database project template is not supported with Visual Studio 2012.
Projects based on the SQL CLR Database project template are automatically upgraded to use the
SQL Server Database project template when opened in Visual COBOL for Eclipse.

Windows Forms

• Microsoft Internet Information Service (IIS) is also required for generating Windows Forms test clients.

XML Extensions

• XML Extensions has the same requirements as RM/COBOL version 12 for 32-bit Windows. (See the
RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions may be used in
conjunction with Terminal Server.

System Requirements for Visual COBOL for Eclipse
(Windows)

Hardware requirements
The disk space requirements for Windows are:

• Approximately 42MB for the Sentinel RMS license server.
• At least 680MB for Visual COBOL.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

The disk space requirements for UNIX/Linux are:

• Between 26 and 35 MB for the Sentinel RMS license server depending on the platform.
• Between 206 and 427 MB for Visual COBOL depending on the platform.

Important: The UNIX installation requires extra disk space that equals the size of the product you
install.
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Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The supported Windows platforms are:

• Windows XP 64-bit SP2
• Windows XP 32-bit SP3
• Windows Vista SP1 32/64-bit
• Windows 7 32/64-bit
• Windows 8 32/64-bit
• Windows Server 2008 SP2 32/64-bit
• Windows Server 2008 R2 32/64-bit
• Windows Server 2012 32/64-bit

Software Requirements

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

• If you use XML Extensions, it has the same requirements as RM/COBOL version 12 for 32-bit
Windows. (See the RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions
may be used in conjunction with Terminal Server.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

System Requirements for Visual COBOL for Eclipse
(UNIX)

Hardware Requirements
The disk space requirements are:

• 33MB for the Sentinel RMS license server.
• Approximately 399MB for Visual COBOL.

Note: The installation requires extra disk space that equals the size of the product you install.
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Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

• x86 running Red Hat Linux 5.5/5.8 - 32/64-bit
• x86 running SuSE SLES 11/11 SP2 - 32/64-bit

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• Before installing on Red Hat 6.x, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• To use the Web installer on Red Hat Enterprise Linux 6.x, you must have the following bug fix updates

for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability.

Note: On AIX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

• You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:
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• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit
Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

System Requirements for Visual COBOL Development
Hub

Hardware Requirements
The disk space requirements are:

• Between 26 and 33 MB for the Sentinel RMS license server depending on the platform.
• Between 206 and 427 MB for Micro Focus Development Hub depending on the platform.

Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported
• POWER running AIX 6.1 TL7 SP5/7.1 TL1 SP5 - 32/64-bit
• x86-64 running Red Hat Linux 5.5/5.8/6.3, Oracle Linux 6.3 with Red Hat Kernel compatibility mode,

Oracle Linux 6.3 with Unbreakable Enterprise Kernel - 32/64-bit
• SPARC running Solaris 10/11 - 32/64-bit
• x86-64 running SuSE SLES 11/11 SP2 - 32/64-bit
• System Z running SuSE SLES 11 SP2 - 32/64-bit
• System Z running Red Hat Linux 6.2/6.3- 32/64-bit
• HP IA 11.31 - 32/64-bit

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• Before installing on Red Hat 6.x, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• To use the Web installer on Red Hat Enterprise Linux 6.x, you must have the following bug fix updates

for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
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nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability.

Note: On AIX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

• You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit
Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

System Requirements for COBOL Server for Windows

Hardware Requirements
The disk space requirements are:

• 42MB for the Sentinel RMS license server.
• About 170MB for COBOL Server.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
The following platforms are supported:
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• Windows XP 64-bit SP2
• Windows XP 32-bit SP3
• Windows Vista SP1 32/64-bit
• Windows 7 32/64-bit
• Windows 8 32/64-bit
• Windows Server 2008 SP2 32/64-bit
• Windows Server 2008 R2 32/64-bit
• Windows Server 2012 32/64 bit

Note:

• COBOL Server 2012 is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

Before installing this product, you must have the following software installed on your computer:

• A version of the Microsoft .NET Framework that is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager.
• Microsoft .NET Framework 4 is required if your applications use the ILCLR(4) Compiler Directive or if

they target the .NET Framework 4.

To download the Microsoft .NET Framework 4 click here.
• Microsoft .NET Framework 4.5 might be required for COBOL applications created with Visual Studio

2012.

Note:

• If you do not target a specific version of the Microsoft .NET Framework, Micro Focus
recommends that you install version 4.

• .NET Framework 3 is provided with Windows Vista, Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7, Windows Server 2008 R2

• Microsoft's Visual C++ 2010 Redistributable Package:

• To download Microsoft's Visual C++ 2010 Redistributable Package (x86) click here.
• To download Microsoft's Visual C++ 2010 Redistributable Package (x64) click here.

Note: If, when you install COBOL Server, the machine does not have Microsoft Visual C++ 2010
Redistributable Runtime already installed, it will be installed as required by COBOL Server. The
installation of Microsoft Visual C++ 2008 Redistributable Runtime will add a number of .dll files,
without digital signatures, into the winsxs directory.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• The Java Development Kit (JDK), version 1.6 (u27 or later) or version 1.7 (u05 or later), is required for
compiling Java. The JDK is downloadable from www.oracle.com. After installing the JDK, you must put
the tools.jar file for the JDK on your classpath, using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar
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Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

System Requirements for COBOL Server for UNIX

Hardware Requirements
The disk space requirements are:

• Between 26MB and 54MB for the Sentinel RMS license server depending on the platform.
• Between 146MB and 350MB for COBOL Server.

Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported
• POWER running AIX 6.1 TL7 SP5/7.1 TL1 SP5 - 32/64-bit
• x86-64 running Red Hat Linux 5.5/5.8/6.3, Oracle Linux 6.3 with Red Hat Kernel compatibility mode,

Oracle Linux 6.3 with Unbreakable Enterprise Kernel - 32/64-bit
• SPARC running Solaris 10/11 - 32/64-bit
• x86-64 running SuSE SLES 11/11 SP2 - 32/64-bit
• System Z running SuSE SLES 11 SP2 - 32/64-bit
• System Z running Red Hat Linux 6.2/6.3- 32/64-bit
• HP IA 11.31 - 32/64-bit

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• Before installing on Red Hat 6.x, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• To use the Web installer on Red Hat Enterprise Linux 6.x, you must have the following bug fix updates

for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
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nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability.

Note: On AIX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:

• Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar
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Installation
Note: If you are installing on Solaris, please read UNIX Installer Issues first.

UNIX Installer Issues

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

License Server

On UNIX, you need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Installing Visual COBOL for Visual Studio
Note:

• This version of the product is a full install.
• It is recommended to install this product using the Web Installer. The Web Installer helps you

install any missing prerequisite software and the product on your machine.

Installation restrictions and requirements
Before starting the installation you should consider the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine.
• If, when you install Visual COBOL for Visual Studio 2010, the machine does not have Microsoft Visual

C++ 2010 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number of .dll files, without
digital signatures, into the winsxs directory.

• If, when you install Visual COBOL for Visual Studio 2012, the machine does not have Microsoft Visual
C++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
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installation of Microsoft Visual C++ 2012 Redistributable Runtime adds a number of .dll files, without
digital signatures, into the winsxs directory.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing Visual COBOL for Visual Studio
To use the Web Installer:

1. Double-click the VisualCOBOLVisualStudio21_webinstaller.exe file.
2. Click Start in the Web Installer dialog and follow the instructions to install the prerequisite software and

the product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the VisualCOBOLVisualStudio21.exe file and follow the wizard instructions to complete the
installation.

Note: If you are installing Visual COBOL for Visual Studio 2012 the files are
VisualCOBOLVisualStudio21_2012_webinstaller.exe and
VisualCOBOLVisualStudio21_2012.exe, respectively.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing as an Upgrade
This release will update existing installations of Visual COBOL 2.1 for Visual Studio.

Before installing, check Installation Restrictions and Requirements.
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After Installing
You are now ready to run Visual COBOL. From the Windows taskbar click Start > All Programs > Micro
Focus Visual COBOL > Visual COBOL for Visual Studio.

Note: The Start menu is not available on Windows 8. You use the Start screen to invoke programs.

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

Note:

• The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

• If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the I want to use local help button.

• Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

• If you do not wish to install Visual Studio 2010 SP1, you can install some third party tools that
enable the index or the fully expanding table of contents. Read http://kb.microfocus.com/
display/4/kb/article.aspx?aid=31484 for more.

• To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

• For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
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3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.

4. Click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL and Micro Focus
License Manager. Uninstalling only Visual COBOL does not automatically uninstall the Micro Focus
License Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

Installing Visual COBOL for Eclipse (Windows)

Installation restrictions and requirements
Before starting the installation, you should consider the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
To use the Web Installer:

1. Double-click the visualcoboleclipse21_update1_webinstaller.exe file.
2. Click Start in the Installer window and follow the instructions to install the prerequisite software and the

product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the visualcoboleclipse21_update1.exe file and follow the wizard instructions to complete
the installation.
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A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Name\eclipse directory. On older versions of Windows, Eclipse
might be installed in a different folder, such as for Windows XP, in install_dir\eclipse.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing into different Eclipse packages
Micro Focus Visual COBOL uses Eclipse 3.7. If you want to use Visual COBOL in other Eclipse packages
based on version 3.7, you must also install the Visual COBOL update site, and the RSE and AspectJ
plugins. Follow the procedure below to do this.

Important: We recommend you back up all existing Eclipse configuration files first.

1. Install Visual COBOL as directed above.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

For Windows environments

1. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Visual COBOL\eclipse\installer to a temporary folder:

• ajdt_2.1.3_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins.
3. Copy %ProgramFiles(x86)%\Micro Focus\Visual COBOLUpdateSite to <your

existing Eclipse>\eclipse\dropins.
4. Rename each of the folders:

• From ajdt_2.1.3_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From UpdateSite to COBOLUpdateSite

5. Move the the contents of the <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite\eclipse folder up a level (that is, to <your existing Eclipse>\eclipse
\dropins\RSEUpdateSite) and delete the empty folder.

6. Copy the eclipse.ini file in %ProgramFiles(x86)%\Micro Focus\Visual COBOL
\eclipse\installer to <your existing Eclipse>\eclipse, overwriting the existing file.

3. Restart Eclipse.
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After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.
3. Click OK.
4. Reapply any customizations.

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Installation | 23



Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Manager. Uninstalling only Visual COBOL does not automatically uninstall the Micro
Focus License Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

UNIX

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus License Manager
or the prerequisite software. To completely remove the product you must uninstall the Micro Focus
License Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL for Eclipse (UNIX)

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
To use the Web Installer:

1. Give the Web installer file execute permissions:

chmod +x webinstaller_visualcobol_deveclipse_2.1_update1_platform

2. Run the installer with superuser permissions:

./webinstaller_visualcobol_deveclipse_2.1_update1_platform

If you don't run this as superuser, you will be prompted to enter the superuser password during the
install.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_2.1_update1_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_deveclipse_2.1_update1_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.
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The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL. A full version
of Eclipse, with the Micro Focus plugins already installed, is present in the /opt/microfocus/
VisualCOBOL/eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./webinstaller_visualcobol_deveclipse_2.1_update1_platform -
installlocation="full path of new location"

or

./setup_visualcobol_deveclipse_2.1_update1_platform -installlocation="full 
path of new location"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the –
skipsafenet option, which skips the installation of SafeNet:

./setup_visualcobol_deveclipse_2.1_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set up the environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

./opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -Version

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Start the Product

To start Eclipse:

1. Double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh
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Installing as an Upgrade
This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

• Move the R4 installation to a different location and install the latest version to the default install
location, /opt/microfocus/VisualCOBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command:

[ as root ] mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL 2.1 Update 1 installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL2.1"

2. Execute cobsetenv to set the environment and point to the new install location:

./opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing into different Eclipse packages
Micro Focus Visual COBOL uses Eclipse 3.7. If you want to use Visual COBOL in other Eclipse packages
based on version 3.7, you must also install the Visual COBOL update site, and the RSE and AspectJ
plugins. Follow the procedure below to do this.

Important: We recommend you back up all existing Eclipse configuration files first.

1. Install Visual COBOL as directed above.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

For UNIX environments

1. Extract the contents of the following .zip files in /opt/microfocus/VisualCOBOL/eclipse to
a temporary folder:

• ajdt_2.1.3_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

• UpdateSite.zip

2. Copy the extracted folders to <your existing Eclipse>/eclipse/dropins.
3. Rename each of the folders:

• From ajdt_2.1.3_for_eclipse_3.7 to AspectJUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From UpdateSite to COBOLUpdateSite

4. Move the the contents of the <your existing Eclipse>/eclipse/dropins/
RSEUpdateSite/eclipse folder up a level (that is, to <your existing Eclipse>/eclipse/
dropins/RSEUpdateSite) and delete the empty folder.

5. Copy the eclipse.ini file in /opt/microfocus/VisualCOBOL/eclipse/eclipse to <your
existing Eclipse>/eclipse, overwriting the existing file.
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6. If necessary, edit eclipse.ini so that the -vm parameter is set to the requisite Java folder.
3. Restart Eclipse.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.
3. Click OK.
4. Reapply any customizations.

Configuring the Environment for Developing RDBMS
Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Uninstalling
To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus License Manager
or the prerequisite software. To completely remove the product you must uninstall the Micro Focus
License Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
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The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
To use the Web Installer:

1. Give the Web installer file execute permissions as follows:

chmod +x webinstaller_visualcobol_devhub_2.1_update1_platform

2. Run the installer with superuser permissions:

./webinstaller_visualcobol_devhub_2.1_update1_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Alternatively, you can use the setup file and install the product as follows:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_2.1_update1_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_2.1_update1_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./webinstaller_visualcobol_devhub_2.1_update1_platform -
installlocation="full path of new location" 

or

./setup_visualcobol_devhub_2.1_update1_platform -installlocation="full path 
of new location"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the –
skipsafenet option, which skips the installation of SafeNet:

./setup_visualcobol_devhub_2.1_update1_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set up the environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

./opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -Version

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Note: For information about the Visual COBOL Development Hub, check the help for Visual COBOL
for Eclipse that is available online on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

• Move the R4 installation to a different location and install the latest version to the default install
location, /opt/microfocus/VisualCOBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command:

[ as root ] mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL 2.1 Update 1 installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL2.1"

2. Execute cobsetenv to set the environment and point to the new install location:

./opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
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Configuring the Environment for Developing RDBMS
Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, then specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.
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For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command (with superuser authority):

$COBDIR/remotedev/stoprdodaemon <port>

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hubfrom one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Uninstalling
To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus License Manager
or the prerequisite software. To completely remove the product you must uninstall the Micro Focus
License Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing COBOL Server for Windows

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
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• Visual COBOL and COBOL Server cannot coexist on the same machine.
• If you are installing this as an upgrade, make sure that none of the product files are in use when you

start the installation.
• You need to be logged in with a user-ID that has write access to the registry structure under

HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• COBOL Server and COBOL Server 2012 can coexist on the same machine.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
To use the Web Installer:

1. Double-click the cobolserver21_update1_2010_webinstaller.exe file.
2. Click Start in the Web Installer dialog and follow the instructions to install the prerequisite software and

the product.

Alternatively, you can use the setup file and install the product as follows:

1. Run the cobolserver21_update1_2010.exe file and follow the wizard instructions to complete the
installation.

Note: If you need to install COBOL Server 2012, the files you need to use are
COBOLServer21_2012_webinstaller.exe and COBOLServer21_2012.exe, respectively.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing as an Upgrade
This release will update an existing installation of COBOL Server 2.1.

Before installing, check Installation Restrictions and Requirements.
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COBOL Server Installation Options
To install COBOL Server you run cobolserver21_update1_2010.exe which contains a number of
product .msi files (Windows Installer packages). When run, cobolserver21_update1_2010.exe
performs some initial system checks then sequentially installs the MSIs.

cobolserver21_update1_2010.exe can take a number of parameters, enabling you to specify a
number of different types of installation:

• Standard Installation

Format:
cobolserver21_update1_2010.exe

Summary:
Full installation including License Manager, Vision, and COBOL Server. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
cobolserver21_update1_2010.exe /qb

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
cobolserver21_update1_2010.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cobolserver21_update1_2010.exe /q /componentargs "Micro Focus COBOL
Server":"INSTALLDIR=d:\cobolrts"

Summary:
Full installation, but the installation is controlled by the /componentargs switch and the standard MSI
property INSTALLDIR. In the example above, COBOL Server is installed into d:\cobolrts.

Note:

• You can display the valid values for the /componentargs switch by using the /displayconfig switch:

cobolserver21_update1_2010.exe /displayconfig

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable.

• You can extract the component .msi files from cobolserver21_update1_2010.exe by using
the by using the /extractcab switch:

start /wait cobolserver21_update1_2010.exe /extractcab

The extracted .msi files are saved in the SupportFiles subfolder.
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After Installing
To open the help, select Start > All Programs > Micro Focus COBOL Server > Documentation from the
Windows Taskbar. From the left hand pane, select Micro Focus Developer > Micro Focus COBOL
Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Manager. Uninstalling only COBOL Server does not automatically uninstall the Micro
Focus License Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing COBOL Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.
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Installing
To use the Web Installer:

1. Give the Web installer file execute permissions once it downloaded:

chmod +x webinstaller_visualcobol_server_2.1_platform

2. Run the installer with superuser permissions:

./webinstaller_visualcobol_server_2.1_platform

If you don't run this as superuser, you will be prompted to enter the superuser password during the
install.

Alternatively, you can use the setup file and install the product as follows:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_server_2.1_update1_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_server_2.1_update1_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./webinstaller_visualcobol_server_2.1_platform -installlocation="full path 
of new location"

or

./setup_visualcobol_server_2.1_update1_platform -installlocation="full path 
of new location"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running on
your machine. During installation licensing is shutdown to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the –skipsafenet option,
which skips the installation of SafeNet:

./setup_visualcobol_server_2.1_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file and
install Sentinel RMS server manually.

After Installing
When you have installed the product, you need to set the environment as described below.
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1. To set up your product, execute:

./opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -Version

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing as an Upgrade
This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

• Move the R4 installation to a different location and install the latest version to the default install
location, /opt/microfocus/VisualCOBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command:

[ as root ] mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL 2.1 Update 1 installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL2.1"

2. Execute cobsetenv to set the environment and point to the new install location:

./opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.

You can use the following command line arguments to install silently on UNIX:

–silent -IacceptEULA

For example, execute:

webinstaller_filename –silent -IacceptEULA

or

setup_filename –silent -IacceptEULA

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.
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Uninstalling
To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus License Manager
or the prerequisite software. To completely remove the product you must uninstall the Micro Focus
License Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• This release uses the license keys for the Visual COBOL R4 release.
• This release requires the latest version of SafeNet licensing software. See Software Requirements

in this document for more details.
• If you are unsure about what your licensing policy is or what sort of license you require, consult

your System Administrator or Micro Focus SupportLine to obtain a valid license.

Note: This package provides eight licenses for using Micro Focus Development Hub on all platforms.

Windows Use the Authorization Code, supplied with your delivery notice, to license your product. To do
this:

1. Click Start > All Programs > Micro Focus License Manager > License Management
System.

The dialog box for the Micro Focus License System Administration Tool will be displayed.
2. Click the Authorize tab.
3. Enter your Authorization Code and click Authorize.
4. Close the Micro Focus License System Administration Tool.

If you wish to install the license silently, execute the following after the product has been
installed:

start /wait <install-dir>\bin\cesadmintool –term activate 
AuthorizationCode

UNIX The Micro Focus Licensing System is installed into the /var/microfocuslicensing
directory.

To license your software:

1. Run the Micro Focus Licensing Administration utility:

sh /var/microfocuslicensing/bin/cesadmintool.sh

Note:

• You need permissions to write to the license file which normally means you need
to log in as root.

• Make sure Java is on the PATH before you run the utility. See System
Requirements for more information.

2. Select an option as appropriate and press Enter:

If you have access to the Internet:

Select Online Authorization. You will be prompted to enter the Authorization Code
supplied with your delivery notice.

If you do not have access to the Internet:

You need the license strings. In order to obtain them, you need your Authorization Code,
your Machine Id and a machine with access to the Internet.

a. Choose Get Machine Id and press Enter.
b. Make a note of the information which is displayed.
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c. On the machine which is connected to the Internet, open http://
supportline.microfocus.com/activation/ in a browser.

d. Follow the instructions to obtain the license strings and save them to a text file.
e. Copy the text file to the first machine on which you are installing the product.
f. At the command line, select Manual License Installation from the licensing options

and enter the full name of the file containing the license strings.
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What's New
The following sections outline the new features that have been added in this release of Visual COBOL for
Eclipse.

New Features in Visual COBOL 2.1 Update 1

Compiler Directives
You can now set SQL Compiler directives and their values more easily, using a table of tick boxes in a
project’s Properties dialog box.

DB2 ECM
• Support for 64-bit DB2 ECM
• Support for 64-bit compile and runtime
• Support for DB2 10.1
• New DB2 SQL compiler directive option, BGP, to enable background parsing

Debugging enhancements
For variables in a copybook that are modified by COPY… REPLACING statements in your code, the Autos
window displays all values defined in the source code. When there are multiple COBOL programs in your
project that perform a COPY… REPLACING in a copybook, the Autos window only uses the replacing
values found in the first COBOL program. In addition, a new command, Open copybook with replaced
values, is now available from the editor for the copybooks that the COPY... REPLACING statements
modify.

You can create a breakpoint for any program in the workspace that your application uses by clicking Run >
Add Program Breakpoint, or clicking the  icon in the Breakpoints view, and entering the name of the
file.

Features Added in Visual COBOL 2.1

ACUCOBOL-GT Data Types in Managed Code
ACUCOBOL-GT data types and sign() variants that were previously only available in native code are now
supported in managed code. Use the Compiler directives COMP1 and COMP2 to set ACUCOBOL-GT
behavior for those particular data types.

ACUCOBOL-GT Library Routines in Managed Code
ACUCOBOL-GT library routines that were previously only available in native code are now supported in
managed code.
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Associating File Extensions With the COBOL
Language
This release includes enhancements to the way you associate file extensions and extensionless files with
the COBOL language.

if you are importing existing COBOL applications into Visual Studio, it is recommended that you create
associations with COBOL within the IDE for any extensions that are not traditionally used in COBOL.

Automatic Directives Detection and Setting
The IDE automatically determines and sets the COBOL dialect, and the CICS and SQL directives on local
or remote native COBOL projects. You can also start a directives scan from within COBOL Explorer -
select Determine Directives from the context menu for the projects or the COBOL source files. This
triggers a scan to determine the COBOL dialect, the CICS and SQL settings, and sets them as Compiler
directives on a file or project level respectively. At the end of the scan, you view the results and choose to
apply the changes.

Compiler Directives
The following new Compiler directives are now available:

DISPLAY Defines the default behavior of standard DISPLAY statements.

COMP1 Specifies the behavior of a COMP-1 data item.

COMP2 Specifies the behavior of a COMP-2 data item.

RESTRICT-GOTO Generates a syntax error for GO TO statements that transfer control to outside of
the current section.

ILSMARTRESTRICT Limits the generation of properties in ILSMARTLINKAGE classes to non-redefining
elementary items.

The following Compiler directive has changed:

• DATAMAP - Two new parameters allow you to display either the address or offset values for data items
in your program.

.int, .gnt and .lbr File Types Support
Support has been added within the IDE for compiling native COBOL applications to the Micro Focus legacy
formats .int and .gnt, and to package these files as a Micro Focus library file (.lbr). Improvements
include:

• An option to compile all native COBOL projects to .int and .gnt code. You can set this on the
Application page in your project's properties.

• A new native COBOL project template, Micro Focus INT/GNT.
• An option to package the .int and .gnt files produced by the project as a Micro Focus .lbr library

files.
• Improvements to the Net Express Project Import wizard that enable you to convert existing Net Express

projects to Visual COBOL projects that compile to .int and .gnt code.

Just-in-time debugging
Visual COBOL now supports "Just-in-time" debugging: when a run-time error occurs, or an application calls
CBL_DEBUGBREAK, the IDE can start automatically with the debugger attached to the failed process.
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JVM Class Library
A new class library, com.microfocus.cobol.runtimeservices, has been introduced to help you
integrate JVM COBOL and Java in the same application.

The library contains the following classes:

CallableProgram Provides a class and annotation that you can use to create a class that can be called
from COBOL.

Interop Provides a class that contains helper methods for loading, calling and cancelling a
program.

RunUnit Provides a container class that allows you to use COBOL programs in a multi user/
session environment.

Full information on these classes is available in Javadoc format for integration in the Eclipse IDE.

Managed COBOL Enhancements
Delegates
and Events

Delegates and events are now implemented on the JVM platform.

This release provides support for combining delegates, using the METHOD keyword to
specify method groups, and implicit conversion from a method group or an anonymous
method to the suitable delegate type.

Handling
Invalid
Numeric
Data

The handling of invalid numeric data is controlled by a number of Compiler directives:
HOSTNUMMOVE, HOSTNUMCOMPARE and SIGNFIXUP. These directives were
previously only available in native code but are now supported in managed code.

Resolving
Types

In this release, the Compiler attempts to resolve types to those defined in the current
compilation unit wherever possible. The Compiler will attempt to resolve such types to an
external name only if no suitable type exists in the current compilation unit. For example:

$set ilusing"System"
class-id MyNamespace.EventHandler.
01 o type EventHandler.                       
end class.

In this release, 01 o type EventHandler. resolves to
MyNamespace.EventHandler and not to System.EventHandler.

Specifying
Properties

In previous versions of the products, properties declared using the PROPERTY keyword
on a data item were generated as final properties. Starting with this release, they are
generated as virtual properties by default. In order to make the properties final, you need
to specify the word FINAL following PROPERTY. This change may affect the generation
of Proxy classes, for example, if you are using WCF.

OpenESQL
SQL
Compiler
Directive
Options

OpenESQL has been enhanced to support the the following new SQL compiler directive
options:

DATE Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
specified.
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TIME Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
used.

DATEDELIM Specifies a single character as the delimiter between the year, month,
and day components to override the default delimiter determined by the
HCOSS DIALECT or DATE directive specification.

TIMEDELIM Specifies a single character as the delimiter between the hour, minute,
and second components to override the default delimiter determined by
the HCOSS DIALECT or TIME directive specification.

TSTAMPSEP Specifies a single character as the separator between the date and time
parts of timestamp and date/time data.

SQL Server We now support Microsoft SQL Server 2012.

UNIX Platforms Support
Support for remote development and deployment of projects has been added for the Linux/390 platform.
Development Hub now supports Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2.

Features Added in Visual COBOL 2.0

Automatic Directives Detection and Setting
It is now possible to automatically determine and set the COBOL dialect and SQL directives on native
COBOL source code. In the COBOL Explorer, select Determine Directives from the context menu for the
projects or the COBOL source files. This triggers a scan to determine the COBOL dialect and SQL settings
and sets them as Compiler directives on a file or project level respectively. At the end of the scan, you view
the results and choose to apply the changes.

This feature works with local or remote native COBOL projects only.

Building Projects to Multiple Output Files
You can now build your native Link Library projects to multiple output files. To configure this, you need to
go in the project properties and set Output To to Multiple Libraries.

COBOL Explorer View
Visual COBOL now includes the COBOL Explorer view in the Eclipse IDE. This allows you to navigate
around COBOL projects in a more useful and convenient way than Eclipse's own Navigator view.

The COBOL Explorer view includes the following features to help you manage your projects:

• For COBOL Project, Remote Project, and Mainframe Project types, COBOL Explorer adds category
folders that automatically group together your project's COBOL programs, copybooks, and output files.
(These folders are not physical folders on the disk, but effectively headings for certain file types.)

• To simplify navigation around your project, you can hide some files that are part of the project, such as
the .cobolBuild, .cobolProj, and .project files, and the .settings folder and its content in
JVM projects. You do this by opening the view menu, selecting Customize View and choosing from the
options.

Filters Choose types of content to hide in COBOL Explorer.
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Option Description

.*resources Any files of type .* such
as .cobolBuild, .cobolProj

Closed projects Resources in closed projects never display, but
you can choose to hide all closed project icons

 too

Empty folders inside COBOL categories Folders mapped to the COBOL Programs and
Copybooks that contain no COBOL program or
copybook files

Non-COBOL projects Projects of types other than those under Micro
Focus COBOL - for example AspectJ, Plug-in, or
Update-site projects

RSE Internal projects Projects generated by the RSE plug-in

Content Choose types of content to show in COBOL Explorer.

Option Description

Working Sets Working sets are subsets of workspace
resources you can choose to show or perform
options on. To define a working set, click Project
> Build Working Set > Select Working Set >
New.

COBOL Elements Non-resource types that are COBOL-specific:

1. x
2. category folders, including those for COBOL

programs and copybooks
3. icons for the different types of COBOL files.
4. overlays for build errors and warnings
5. some context menu items

Resources COBOL projects, COBOL programs and
copybooks. Has effect only if the COBOL
Elements option is unchecked.

• COBOL Explorer helps you fix problems by using icons to identify files and containers that cause build
errors and warnings.

• A file that generates a warning, and any containing folders and categories, is marked with a yellow
warning sign. For example:
 

 
• A file that causes an error, and any containing folders and categories, is marked with a cross. In this

example the icons indicate the most severe problem is the error caused by Program4.cbl, and
the folders are marked with error icons despite Program5.cbl generating a warning:
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• A project that suffers from a dependency error is marked with a red exclamation mark; its contents

remain unmarked. In this example the project depends on another project that is closed, causing a
build path problem:
 

 

Also, the context menus are reorganized and include some additional tasks such as the Determine
Directives command.

You access COBOL Explorer in the same way as other Eclipse views, by selecting Window > Show View.

COBOL File Search
Visual COBOL now includes the COBOL File Search feature in the Eclipse IDE.

There are two ways to use the COBOL File Search feature to make it easier to find certain files within your
projects.

• Select Search > COBOL File, and type the filename search string.

You can filter results based on

• file type: choose from COBOL programs, copybooks.
• only those files that cause build errors
• only those files that cause build warnings

• Select Search > Run Stored COBOL Search Query and choose to find either:

• only those files that cause build errors
• only those files whose properties override the project's properties (for example Language dialect or

Compile for debugging settings).

The results are shown in the Search view.

You can edit the properties of multiple files in the search results simultaneously if they come from the same
project. Highlight the files you want to change, right-click and select Properties, and make sure Enable
file specific settings is selected.

Tip: You can save your search criteria and give it a label, which adds it to the list of stored queries
available when you select Search > Run Stored COBOL Search Query. When saving a search you
can also assign it a keyboard shortcut by entering the required keystrokes in the Binding text box.

Save and edit your search either in the Search view, or the Windows > Preferences > Micro Focus
> Search dialog box.

Make sure you don't open the Keys preferences page (Windows > Preferences > General > Keys)
before or after you edit the binding in the Search preferences page, and before clicking OK to save
any changes. Opening the Keys preferences page will prevent any changes you make to the search
bindings being saved.
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Compiler Directives
The following new directives are now available:

• COPYSEARCH - enables you to specify how copybooks are located. You can choose between usual
Micro Focus COBOL behavior or usual RM/COBOL behavior.

• ILSMARTNEST - enables you to nest ILSMARTLINKAGE classes inside the program class in which
they are defined. This makes it possible to have multiple programs in a single compilation unit that
include linkage records with the same name.

The following directives have been changed:

• DIALECT(RM) - now accepts a new parameter, RM, which enables the RM-compatible functionality that
the RM directive used to enable.

• ILREF - can only specify a .class as a parameter, and not a .jar file or other file types.
• ILUSING - when set on a single file using the SET statement, $set ilusing, the directive only affects

that file.

Compiling Single Files
It is now possible to compile individual COBOL source files without rebuilding your entire project. Build
Automatically on the Project menu must be turned off.

Enhancements to Developing Applications on a
Remote Machine
Previously, this product depended on Samba or NFS to transfer and manage the project files on a remote
UNIX machine. Remote Server Explorer (RSE) was only used to build the applications on remote
machines.

"Remote file system (RSE)" is now the default option in the Create Remote COBOL project wizard for
managing the files of remote COBOL projects. RSE establishes a connection with the remote machine and
is used to transfer and manage the project files on it.

Important:

• You must use SSH connection and not DStore for remote COBOL projects created with Remote
file system (RSE).

• You can still use Samba and NFS as file system providers. On system where SSH is not allowed,
you can use SAMBA and DStore connection to transfer and manage the files on the remote
system.

Converting Net Express Projects
Visual COBOL includes a Net Express Project Import Wizard that converts Net Express projects into Visual
Studio solutions. The wizard analyzes the Net Express project file and its configuration settings, creates
one or more Visual Studio native projects based on this information, imports the existing source code into
them and sets the appropriate directives. When the process is complete, it can optionally display a detailed
conversion report.

It is now possible to convert Net Express projects into Eclipse projects and use them with Visual COBOL.
To do this, use the Net Express Project Import and Convert Wizard available from File > Import > Convert
NetExpress Projects to COBOL Projects. The wizard analyzes the Net Express project file and its
configuration settings, creates Eclipse projects based on this information, imports the existing source code
into them, and sets the requisite project and file properties from the original Net Express project.
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Note: If you import a Net Express project that uses functionality that is not supported in Visual
COBOL, the wizard will still produce an Eclipsea Visual Studio project. In some cases you might be
able to perform additional steps (such as editing source files, installing AddPacks, or reworking parts
of the application) in order to successfully compile and run it. See Converting Net Express Projects to
Eclipse Projects for more information about the limitations of the wizard.

Copybook Context
When you view or edit a copybook, you need to see it in the context of the program that references it, as its
appearance and usage can change depending on the program. For example, data items that are not used
in the program are struck through, and horizontal lines indicating the start and end of code lines can show
depending on the source format of the program. The Program Outline view can differ between contexts
too.

You can choose which context to open a copybook by right-clicking on the file in COBOL Explorer and
selecting Open In Context. A list is displayed of all the programs that include a COPY statement
referencing the copybook. You can also choose to open the copybook in no particular context.

Whichever you choose becomes the copybook's context whenever you right-click the copybook in COBOL
Explorer and select Open. It also determines which program it is displayed within when you right-click in
the copybook source and select Open in Copy View.

A breadcrumb trail at the top of the Editor indicates which program and copybooks are the current context -

click Toggle Context Breadcrumbs  in the Eclipse toolbar and use the drop-down list to view and open
the dependent copybooks.

Debugging Enhancements
This release provides the following enhancements to debugging:

Core dump
files

On Windows, the core dump files created by this product are Microsoft minidump files. If
you have a mixed language application you can use the minidump file to debug the other
languages involved.

Debugging
native COBOL
Link Library
projects

You can now debug native COBOL link library projects that get built to a single .dll file.

Program
Breakpoints

Note: Program breakpoints are supported in native COBOL only, and are not
supported with nested programs.
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Use the Program Breakpoints (Native COBOL) window to add program breakpoints to
your applications. When a program breakpoint is set the application breaks whenever
the program or one of its entry points is called.

In the Program Breakpoints (Native COBOL) window, click New and type the name of
the source file, without the extension. For multi-program source files, to set a break for a
sub-program, use its program-id.

To display the Program Breakpoints (Native COBOL) window, click Debug >
Windows > Program Breakpoints (Native COBOL).

You can now set program breakpoints, which break into a program whenever it or one of
its entry points is called.

To set or toggle a program breakpoint, double-click in the left margin, next to the
Procedure Division heading. The  icon appears when the program breakpoint is set.

Step out of
OSVS perform
statements

You can now step out of a perform statement when PERFORM-TYPE(OSVS) or
DIALECT(OSVS) is set.

Support for
debug
attaching to
programs
launched by
services

Visual COBOL now supports debugging of native CGI applications by waiting for
attachment on a directory.

Wait for
debuggable
attachment
option for
native COBOL

Wait for debuggable attachment on the Debug page in the properties of native
properties has been enhanced. You can now specify one the following options for it -
Wait for any program, Wait for directory, and Wait for ID.

Eclipse 3.7
This release of Visual COBOL uses Eclipse 3.7.1 Indigo.
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JVM COBOL File Handler
Use the JVM COBOL File Handler, a File Handler written in purely JVM COBOL managed code, when you
are deploying to environments that do not allow the use of native code such as the default Micro Focus File
Handler.

Library Routines
The following CTF library routines are now available in COBOL for JVM:

CBL_CTF_COMP_PROPERTY_GET
CBL_CTF_TRACE
CBL_CTF_TRACER_LEVEL_GET
CBL_CTF_TRACER_GET
CBL_CTF_LEVEL

The following routine has been enhanced:

• The CBL_SEMAPHORE_ACQUIRE routine now accepts a timeout parameter.

Managed COBOL Language Features
The following new syntax elements are now available in managed COBOL:

Local
Variables

In managed COBOL, Data items can now be declared in the procedure division, using
the DECLARE statement. In addition, they can be declared inline as the iterator in a
PERFORM statement, or as an exception message in a TRY … CATCH … FINALLY
statement block.

Collections There are two new collection types in managed COBOL: LIST and DICTIONARY. For a
LIST, you can add elements to a list, retrieve the nth element of the list, replace the nth
element, iterate through the list and clear the list. For a DICTIONARY, you can add key
value pairs, retrieve a value corresponding to a key, to replace the value corresponding
to a key, iterate through the dictionary and clear the dictionary.

Properties In managed COBOL, a property can now be defined using PROPERTY-ID and GETTER
and SETTER phrases to access to the property. The previous technique of specifying
the keyword PROPERTY on a data declaration is still available.

Indexers In managed COBOL, an indexer can now be defined using INDEXER-ID and GETTER
and SETTER phrases to access the indexer value. Indexers are similar to properties,
except that their accessors take parameters. Indexers allow instances of a class or
valuetype to be indexed just like arrays.

Zero-based
Indexing

The managed COBOL syntax for arrays now uses zero-base indexing to access arrays
when square brackets are specified. For backward compatibility, one-base indexing is
used when round parentheses are specified.

The Help now contains code examples comparing managed COBOL and Java.

Data Access
This release provides the following enhancements:

• Improved IDE integration with SQL directives - now supports handling of deprecated and removed
directives. Also supports filtering of the choices offered to the user by product type, project type, and
platform.
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• OpenESQL has been enhanced and it now:

• defaults to optimal performance
• supports 64bit ODBC across all platforms
• OpenESQL now supports JDBC across all platforms

Remote COBOL JVM Projects - Early Release
You can use Eclipse to develop COBOL JVM projects on a remote UNIX/Linux machine. The source code
resides and is being compiled and debugged on the remote machine.

Run-Time Tunables
This release provides the following new tunables:

• printer_raw_redirection - use this to redirect WRITE statements through the Windows print spooler as
RAW data types.

• subsystem_cancel_mode - use this to override the default cancel mode when you use the
CBL_SUBSYSTEM library routine to cancel a subsystem.

Samples
The following new samples are now available:

• CGI demonstrations:

• Complex CGI application - demonstrates how to use native COBOL to create CGI programs which
accept data from a form on a Web page and then redisplay that data in another Web page

• Simple CGI application - demonstrates how to use native COBOL to create CGI programs which
accept data from a form on a Web page and then redisplay that data in another Web page

• The following samples have been added to the COBOL for .NET section:

• Collections - demonstrates the new LIST and DICTIONARY collection types
• Local Variables - shows how to declare data items in the procedure division in the DECLARE,

PERFORM and TRY statements
• The code in the Properties sample in the COBOL for .NET section of Samples Browser has been

enhanced to use the new PROPERTY-ID syntax. The sample also includes a sample program for
Indexers which illustrates the new INDEXER-ID syntax.

• Collections - demonstrates the managed COBOL collections syntax
• Local Variables - shows how to declare data items in the procedure division in the DECLARE,

PERFORM and TRY statements
• The code in the Properties sample has been enhanced to use the new PROPERTY-ID syntax. The

sample also includes a sample program for Indexers which illustrates the new INDEXER-ID syntax.

Vision Data File Searching
This release provides the following new ACUCOBOL-GT compatible environment variables to help search
for Vision data files at run time:

APPLY_FILE_PATH
FILE_CASE
FILE_PREFIX
FILE_SUFFIX
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XML Support
The IBM-style XML GENERATE syntax is now supported in .NET managed COBOL.

Features Added in Visual COBOL 2010 R4 Update 2

Documentation for the Dialog System AddPack
Documentation for the Dialog System AddPack is now available and is integrated with the Visual COBOL
documentation.

This documentation describes the AddPack, which enables you to modernize Dialog System applications
within Visual COBOL. You migrate an application to Visual COBOL and from there you can run the
application without change, or modernize it over time.

The documentation describes some modernization techniques such as:

• A Windows Forms form replacing a Dialog System dialog, where the form can contain .NET controls.
See the Customer + .NET WinForm sample CustomerWinForm.sln.

• A Windows Forms control wrapped as an ActiveX control and used on a Dialog System dialog. See the
Customer + .NET GridView User Control sample custgrid.sln.

• A WPF user control hosted by a Windows Forms user control, which is then exposed as ActiveX ready
for use by Dialog System. See the Customer + .NET WPF GridView User Control sample
CustGridWPF.sln

• A .NET managed code application interacting with Dialog System as native COBOL .dll or as . See
the Managed Customer sample ManagedCustomer.sln.

Note: The Compatibility AddPack for Visual COBOL is not part of Visual COBOL or COBOL Server. It
is separately installable and available from Micro Focus SupportLine.

New Platforms Support
Support for Visual COBOL for Eclipse has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for Visual COBOL Development Hub has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for COBOL for JVM has been added for the following platforms:

HP IA 11.31 - 32/64-bit
x86-64 running Red Hat Linux 5.6/6.1 - 32/64-bit
SPARC running Solaris 10 - 32/64-bit

OO COBOL Class Library Reference
On Windows, Help for the following OO COBOL class libraries is available:

Base class library
GUI class library
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OLE class library
OLE Automation class library

The Help is available in the file nxrclr.chm, which is installed in the Help folder of your installation. The
default location is%ProgramFiles(x86)%\Micro Focus\Visual COBOL\Help.

To open the help, double-click nxrclr.chm in Windows Explorer.

Help for the OO COBOL class libraries are available from the Micro Focus SupportLine Web site, as
follows:

1. Go to the Server Express documentation, at http://supportline.microfocus.com/documentation/books/
sx51ws02/sx51indx.htm.

2. Click Reference > OO COBOL.
3. Expand OO COBOL Class Library Reference.

Net Express Project Import Wizard
Visual COBOL for Visual Studio includes a Net Express Project Import Wizard that converts NetExpress
projects into Visual Studio solutions. The wizard analyzes the Net Express project file and its configuration
settings, creates one or more Visual Studio native projects based on this information, imports the existing
source code into them and sets the appropriate directives. When the process is complete, it can optionally
display a detailed conversion report.

OpenESQL
OpenESQL now includes the JDBC preprocessor option that you can use to access databases for
applications running under the Java Virtual Machine (JVM).

Features Added in Visual COBOL 2010 R4

ACUCOBOL-GT Compatibility
The Compiler and run-time continue to provide support for ACUCOBOL-GT. The directive ACU is the main
switch for turning on ACUCOBOL-GT compatibility. The ACU directive enables various ACUCOBOL-GT
syntax extensions and other language elements. Additional ACUCOBOL-GT compatibility features include
the following:

• When using a CALL statement, the USING and GIVING/RETURNING phrases can now appear in
either order.

• The following ACUCOBOL-GT standard library routines can now be used with Visual COBOL in native
code:

• C$CALLEDBY
• C$CALLERR
• C$CHDIR
• C$MAKEDIR
• C$MEMCPY
• C$MYFILE
• C$PARAMSIZE
• C$RERR
• M$ALLOC
• M$FREE
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• M$COPY
• M$FILL
• M$GET
• M$PUT
• WIN$VERSION

• The following ACUCOBOL-GT 'ccbl' compiler options can now be used with Visual COBOL:

• -E, -V
• -Cv
• -Da, -Db, -Dd31, -DL1/2/4/8, -Dq, -FpRounding
• -La, -Li, -Lc, -Lf, -Ll, -Lo, -Ls, -Lw

Note: The output that these list options provide differs in Visual COBOL.
• -Qm
• -Rc, -Rn, -Rw
• -Sa, -St, -Sd, -Sp, -S1...-S9
• -noTRUNC, -truncANSI, -Dz
• -Td, -Te
• -Vc
• -Za, -Zc, -Zl, -Zn, -Zs, -Zi, -Zr1, -Zy, -arithmeticVSC2

Full ACUCOBOL-GT compatibility is documented under the Programming section in the product help.

COBOL for Java Virtual Machine (JVM) Support
In this release you can compile COBOL applications to JVM byte code (.class files) so that they can be
run on a JVM. There is support in the IDE to edit, compile and debug JVM COBOL applications. This
release includes Managed COBOL - COBOL with extensions to support the JVM framework plus OO
syntax support.

Features include support for

• New managed COBOL syntax:

• The SYNC statement, which marks a statement block as a critical section by obtaining the mutual-
exclusion lock for a given object, executing a block of statements, and then releasing the lock.

• Extension methods, enabling you to extend an existing class with new methods without the need to
recompile the existing class

• Java style inner classes, which define a nested class within another class. These follow all the
methods belonging to the containing class.

• The STATIC keyword, enabling you to mark methods and data as static.
• Enumerators, which represent a list of constant values. You can declare an enum type that defines

the values and symbolic names for them, and refer to the values by name in your code.
• Seamless interoperation between JVM COBOL and native COBOL
• The ability to add Java projects to the classpath for COBOL JVM projects, and COBOL JVM projects to

the classpath for Java projects
• Red Hat, AIX and SUSE platforms

Creating Projects from Selected Files
A new option, Create Project From Selection, is now available for your projects in Solution Explorer. You
can select a number of COBOL files and copybooks in your project and opt to create a new project from
them in the same solution.

What's New | 53



Debugging Enhancements
The ability to load core dump files in Visual Studio has been added. This feature works with native COBOL
only.

Documentation
If you are using Visual Studio 2010 Service Pack 1, the help is displayed in a stand-alone help viewer with
an index and a fully expandable table of contents.

Embedded HTML
We now support the use of Embedded HTML (EHTML) in COBOL CGI programs, which enables you to
output HTML directly from your applications.

Improved Usability
The following improvements to COBOL development in Eclipse have been made:

Dialog box improvements The dialog boxes governing build configuration, debug configuration,
and launch configuration are redesigned to make them easier to use.

Autocompletion and Content
Assist

The IDE now includes autocompletion and content assist editing
features.

Improvements to the Implements Smart Tag
The implements smart tag now supports value-types in addition to classes.

Language Improvements
The following improvements have been made to managed COBOL:

Extension methods
and extending
operators

Managed COBOL now supports extension methods. This feature enables you to
add methods to existing types without the need to edit or recompile the code. You
can also extend operators.

The SYNC modifier
for methods

The SYNC modifier locks the values of the arguments sent to the method, so that
they do not change while the method is processing.

Nested classes In managed COBOL, a nested class can now be defined so that it can access the
instance fields, properties and methods in its containing class. To allow this, you
add the optional SHARING PARENT phrase to the nested class definition.

Large Projects Support
Visual COBOL has been optimized to work with bigger, more complex applications. This includes faster
processing of multiple files and various IDE features that facilitate the process of developing large-scale
project.

You can quickly move existing COBOL code into Visual Studio with the help of various wizards and
windows such as the Create Project from Existing Code wizard and the Create Project from Selection
wizard. The IDE is preconfigured so that during the file import it automatically scans the files and sets
Compiler directives on them as appropriate.
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New Compiler Directives
The following new Compiler directives are provided:

• ILCUTPREFIX - removes a specified prefix from the names of the COBOL data items in your source
code.

• ILSMARTLINKAGE - exposes the Linkage Section and entry points to managed code by creating types.
• RUNTIME-ENCODING - determines the runtime encoding.
• SOURCE-ENCODING - passes the encoding of the source program to the Compiler.

New Samples and Tutorial
New samples and a new tutorial showing how to create WCF services in COBOL are available.

Project Details Window
A new window, Project Details, is available for your COBOL projects and solutions showing a complete list
of the files in a project or a solution and various file details. You can open the window from the context
menu for a project or a solution in Solution Explorer.

Project Properties Updates
The project properties pages have been restructured to make setting options more intuitive.

Renamed Color Preferences
The COBOL Editor syntax-coloring scheme called "Micro Focus Net Express" is now called "Micro Focus
Traditional".

The syntax-coloring element called "Identifiers" is now called "Identification Division Names".

Any existing settings for these options will not change.

Reporting of Linker Errors
Errors relating to linking, such as undefined entry points and libraries not being found, are now logged in
Eclipse's Problems view.

RM/COBOL Compatibility
The Compiler and run-time continue to provide support for RM/COBOL. Additional RM/COBOL
compatibility features include the following:

• The following RM/COBOL standard library routines can now be used with Visual COBOL in native code:

• C$Century
• C$ConvertAnsiToOem
• C$ConvertOemToAnsi
• C$DARG
• C$Delay
• C$GetEnv
• C$GetNativeCharset
• C$LogicalAnd
• C$LogicalComplement
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• C$LogicalOr
• C$LogicalShiftLeft
• C$LogicalShiftRight
• C$LogicalXor
• C$NARG
• C$SetEnv
• C$RERR
• DELETE
• RENAME

• The RM/COBOL file handler can now be used with Visual COBOL, enabled by using the
CALLFH(ACUFH) Compiler directive, and then configuring an add-on to the Vision file handler.

Full RM/COBOL compatibility is documented under the Programming section in the product help.

Smart Linkage
Exposing COBOL
group items as
managed types

You can expose COBOL Linkage sections to other managed languages by
using the ILSMARTLINKAGE directive. Smart Linkage saves the need to edit
your original COBOL code or write wrapper classes.

WCF Services and Service References
Support is now available for adding WCF services as service references to your COBOL projects.

Note: WCF is not supported in the Visual Studio Shell but adding service references for client applications
is supported.

XML Extensions
Note: This functionality is supported in native COBOL only.

You can now use XML Extensions, the system that enables your COBOL applications to interact with XML
documents, with Visual COBOL.

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
RM/COBOL product documentation set, in the SupportLine section of the Micro Focus Web site.

Features Added in Visual COBOL 2010 R3

.NET COBOL Syntax Improvements
Quoteless syntax Quotes are not needed when defining types, classes or methods, or

when invoking classes and methods.

Construct improvements The structure of class-id, method-id, enum-id, delegate-id, interface-id,
valuetype-id has been improved.
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Environment division,
Configuration section,
Repository

The Environment division, Configuration section and the Repository are
no longer needed.

Static, Factory and Object
blocks

The Static, Factory and Object blocks are no longer needed.

Attributes, Custom-Attribute
and Class-Attributes

CUSTOM-ATTRIBUTE is now replaced by the ATTRIBUTES phrase.
You no longer need to define class-attributes. Instead, specify the class
custom attributes in the class definition.

Tip:

• Visual COBOL supports the older syntax, so projects that are using it will still compile. However, it
is recommended to create applications using the new syntax and adhere to the .NET COBOL Best
Practices.

• It is recommended to use the COBOL project and file templates, snippets and Intellisense as they
use the new syntax. To see the new syntax in action, check the Visual COBOL samples.

The following is a more detailed overview of the changes in the syntax with examples:

Quoteless Syntax

Quotes are no longer needed when you define types, classes or methods, or when you invoke classes and
methods. For example:

New Syntax Old Syntax

01 o1 type MyClass 01 o1 type "MyClass"

type MyClass::New type "MyClass"::"New"

set o to new MyClass set o to new "MyClass"

set class::Property to value set "class"::"Property" to value

set return-value to 
class::Method(param1)

set return-value to 
"class"::"Method"(param1)

invoke class::Method(param1) invoke "class"::"Method"(param1)

       method-id MyMethod public.
       
       local-storage section.
       
       procedure division.
       
           goback.
       end method.

       method-id. "MyMethod" public.
                local-storage section.
                
                procedure division.
                    goback. 
                end method "MyMethod".

Construct of class-id, method-id, enum-id, delegate-id, interface-id, valuetype-id

The construct of class-id, method-id, enum-id, delegate-id, interface-id, valuetype-id has been improved as
follows:

• You do not have to type a period after the declaration (for example, method-id MethodName).
• Quotes are no longer required around names.
• You do not need to use the name in the end marker.
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New Syntax Old Syntax

       class-id Namespace.MyClass.
      
       object-storage section.

       method-id InstanceMethod.
       local-storage section.
       procedure division.
           goback.           
       end method.

       method-id StaticMethod public 
static.
       local-storage section.
       procedure division.
           goback.           
       end method.

       end class.

       class-id. MyClass as 
"Namespace.MyClass".
       environment division.
       configuration section.
       repository.
      
       static.
       working-storage section.
      
       end static.
      
       object.
       working-storage section.

       method-id. "InstanceMethod".
       local-storage section.
       procedure division.

           goback.           
       end method "InstanceMethod".
      
       end object.
       end class MyClass.

Environment Division, Configuration Section, Repository

You no longer need to use an Environment division, a Configuration section or a Repository paragraph. For
example:

New Syntax Old Syntax

       program-id. Program1 as 
"MyProject.Program1".

       data division.
       working-storage section.
       procedure division.

           goback.
       end program Program1.

       program-id. Program1 as 
"MyProject.Program1".

       environment division.
       configuration section.
       repository.
       

       data division.
       working-storage section.
       procedure division.

           goback.
       end program Program1.

Static, Factory and Object Blocks

The Static and Object blocks are no longer used. With the new syntax you need only one working-storage
section for items that were defined in a static or object block under the old syntax.

To define a static method, use the STATIC word.

The following example shows how to define static methods with the new syntax and how to avoid using an
object block:

58 | What's New



New Syntax Old Syntax

       class-id Namespace.MyClass.
      
       working-storage section.
       01 my-object-data pic x.
       01 my-static-data pic x static.

       method-id InstanceMethod.
       local-storage section.
       procedure division.
           goback.           
       end method.

       method-id StaticMethod public 
static.
       local-storage section.
       procedure division.
           goback.           
       end method.

       end class.

       class-id. MyClass as 
"Namespace.MyClass".
       environment division.
       configuration section.
       repository.
      
       static.
       working-storage section.
         01 my-static-data pic x.
       end static.
      
       object.
       working-storage section.
         01 my-object-data pic x.

       method-id. "InstanceMethod".
       local-storage section.
       procedure division.

           goback.           
       end method "InstanceMethod".
      
       end object.
       end class MyClass.

Attributes, Custom-Attribute and Class-Attributes

These are the changes for CUSTOM-ATTRIBUTE and class-attributes:

• The CUSTOM-ATTRIBUTE phrase is replaced by the ATTRIBUTE phrase.
• You no longer have to define class-attributes. Instead, specify the class custom-attributes in the

class definition using the ATTRIBUTE phrase.
• Quotes are no longer needed around the name of the attribute and you can omit the word "Attribute"

from the name.

For example:

New Syntax Old Syntax

       class-id 
MyNamespace.MyClass.          
           attribute Serializable.
       
       working-storage section.
       ...

       end class.

       class-id. MyClass as 
"MyNamespace.MyClass".
       
       class-attributes.
       custom-attribute is type 
"SerializableAttribute".
       
       object.
       
       working-storage section.
          ...
      
       end object.

       end class MyClass.

Creating Projects from Existing Code
Now you can create Visual Studio COBOL projects from existing applications using the Create New Project
from Existing Code Files wizard. The wizard will create a new COBOL project and automatically add files to
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it from the specified directories. It will perform an automatic file scanning to identify which files are
programs and copybooks, so that they can be correctly added to the project.

Add Existing COBOL Items Wizard
You can add existing COBOL files to your Visual Studio project using the new Add Existing COBOL Items
wizard available from the context menu of the project in Solution Explorer. The COBOL files will be
scanned to determine which ones are programs or copybooks, and then they will be added to the project.
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Override Class Members Dialog
Note: This feature works with .NET managed code only.

The new Override Class Members dialog available in the editor enables you to override the members of
inherited classes. The dialog helps you see the base classes from which a class inherits, select the
members to override and add the construct of the overriding methods to the class.
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Smart Tag for Implementing Interfaces
Note: This feature works with .NET managed code only.

You can now easily implement interfaces with the help of a Smart Tag. The tag appears underneath at the
beginning of the declaration of any interface that is not fully implemented. To implement the interface, you
simply need to click the tag.

Snippet for Implements
Note: This feature works with .NET managed code only.

The snippet for implements has been improved. It now automatically implements the members from an
interface and has improved support for more complex method signatures.

Navigate To
Use the Navigate To option in the Edit menu to search for files, variables and section names in all projects
and files in your solution.
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Find All References
The Find All References option available from the editor enables you to search for references of COBOL
data items, section or paragraph names in your solution.

Web Application Projects
Note: This feature works with .NET managed code only.

This release offers Web Application Project templates for creating COBOL Web applications and Web sites
and applications. The benefits of using a Web Application project include:

• A Web Application project includes a project file which enables you to specify what files are part of the
project and should be compiled.
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• It adds namespaces for all items of the project.
• The source code is compiled into a single assembly on your local machine and is then deployed to the

IIS server. You don’t have to deploy the code behind.
• A Web Application project includes a “Publish” option for deploying the compiled assembly to an IIS

server directly from the IDE using the automated tools of Visual Studio.
• Supports the Visual Studio Code Analysis feature.

Debugging
The following debugging enhancements have been made:

• COBOL watchpoints and break on data change - you can set COBOL watchpoints on individual data
items in native COBOL. COBOL watchpoints enable you to watch the area of memory associated with
the particular data item and help track memory corruption. When the memory changes, debugging
stops on the line that immediately follows the line on which the data has changed. This feature works
with native code only.

• Watchpoints (Native COBOL) window - enables you to manage the COBOL watchpoints you add to
your applications and view the contents of the memory associated with each watchpoint. This feature
works with native code only.
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• Simplified remote debugging - a simplified process for setting up remote debugging is provided.
• Attach to 64-bit process and debug - provides the ability to attach to and debug 64-bit COBOL

processes.
• Debug tooltip for OCCURS items - you can now specify whether the debug tooltips for OCCURS items

should display all items in an array or the value of an expression.

Samples Browser
You can preview the samples and access them more easily with the help of the Samples Browser which is
now available from the Start menu. Samples Browser lists the samples by category
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ACUCOBOL-GT Compatibility and RM/COBOL
The Compiler and run-time now include initial support for ACUCOBOL-GT. This support is enabled by
several new Compiler directives. The directive ACU is the main switch for turning on ACUCOBOL-GT
compatibility. The ACU directive enables various ACUCOBOL-GT syntax extensions and other language
elements. Additional ACUCOBOL-GT compatibility features include the following:

• Vision indexed file system and utilities (vutil, vio, and logutil) support. Vision support is enabled by the
new CALLFH(ACUFH) option.

• ACUCOBOL-GT compiler options. By using the new ACUOPT directive you can specify the same
options available in ACUCOBOL-GT.

• ACUCOBOL-GT and RM/COBOL data type support. This enables you to mix ACUCOBOL-GT and
Micro Focus Visual COBOL applications via data files or calls.

• Initial ACUCOBOL-GT syntax support. The Compiler now supports some of the ACUCOBOL-GT
extensions.

• Interoperability between ACUCOBOL-GT and Visual COBOL components. You can begin to build
applications that combine ACUCOBOL-GT with Visual COBOL features.

ACUCOBOL-GT compatibility is documented under the Programming section in the product help.
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XML Support
Enhancements have been made to XML Parse/Generate to provide compatibility with IBM® Enterprise
COBOL for z/OS® v4.2.

New in XMLGENERATE:

• ATTRIBUTES phrase
• NAMESPACE and NAMESPACE-PREFIX phrases
• XML-DECLARATION phrase

New in XMLPARSE:

There are now two modes of XMLPARSE support using the XMLPARSE() compiler directive:

• XMLPARSE(COMPAT) – provides compatibility with IBM Enterprise COBOL for z/OS v4.1 and earlier.
• XMLPARSE(XMLSS) – provides compatibility with IBM Enterprise COBOL for z/OS v4.2.

XMLPARSE(XMLSS) provides:

• ENCODING phrase
• RETURNING NATIONAL phrase
• VALIDATING phrase
• New special registers - XML-NAMESPACE, XML-NNAMESPACE, XML-NAMEPSACE-PREFIX and

XML-NNAMESPACE-PREFIX.
• New behaviors – for example, different return codes, different output registers depending on the

EVENT.

Note: The ability to parse XML documents one segment at a time with the help of the END-OF-INPUT XML
event is not supported yet.

Features Added in Visual COBOL 2010 R2

File Handler
The Micro Focus File Handler is now provided as both verifiable and non-verifiable versions. Compiling
your application with the ILVERIFY directive will automatically reference the verifiable File Handler
assembly.

Go To Procedure Division
The Go To Procedure Division button is now available on the Go To Location toolbar. Clicking the button
positions the cursor on a Procedure Division depending on the current context of the code.

OpenESQL Assistant
Support for the OpenESQL Assistant has been added. The OpenESQL Assistant is an interactive tool that
enables you to easily design and build SQL queries and embed those queries into your COBOL code.
Features include:

• Prototype SQL SELECT statements and test them against a database
• Design SQL INSERT, UPDATE, and DELETE statements
• Insert SQL queries into the COBOL code
• Create and insert auxiliary code into your COBOL code
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Samples
The following games have been added to the samples:

• COBOL Blitz - A shooter game in which the players use a laser cannon to defend themselves against
the invasion of aliens troops. The goal is to destroy the troops and prevent them from reaching the
bottom of the screen.

Special Features:

• 2D graphics
• Audio effects

• Snake - An arcade game in which the player navigates a long chain of symbols across the screen and
scores by collecting numbers. Numbers add to the overall length and the speed of the snake. The
player needs to avoid hitting the borders of the screen or touching the snake's body as this terminates
the game.

• Tic-Tac-Toe - The player competes with the PC to place three identical marks in a horizontal, vertical,
or diagonal row on the 3x3 board.

Snippets
This release provides new snippets for Attribute, DateTime, Implements and for static methods.

SQL Support
The SQL technology that was present in Net Express is now seamlessly integrated within the Visual Studio
2010 development environment. When you develop COBOL SQL applications in Visual Studio, you can
use the same development environment to extend and modernize your COBOL assets.

Features include:

• OpenESQL technology that supports embedded SQL in your COBOL applications
• OpenESQL Assistant wizard that automatically generates embedded SQL in a COBOL program

template given basic database information
• DB/2 ECM technology that uses embedded SQL to work with DB2 LUW
• COBSQL processor that provides native DBMS SQL support for Oracle's Pro*COBOL and other

vendors

XML Parse/Generate
Visual COBOL now supports the IBM-style XML syntax and enables your applications to process XML
data. Support for the XML PARSE and XML GENERATE statements is provided in the Visual COBOL
compiler.

Features Added in Visual COBOL 2010 R1

Visual Studio as the Core Integrated Development
Environment
The Visual Studio editor has been extended in a number of ways to enhance its support for COBOL,
including Standard Visual Studio 2010 features for program navigation are exploited for COBOL
applications.
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• Fully integrated COBOL development environment delivers high programmer productivity by exploiting
Visual Studio tools and providing instant feedback.

• Enhanced COBOL syntax for .NET programmers makes it easier for COBOL programmers to use .NET
services or for programmers with .NET experience in other programming languages to be productive
with COBOL.

• Visual COBOL supports the development and deployment of both "managed" .NET (with multi-targeting
for .NET Framework V4 and earlier versions) and "unmanaged", native code applications.

• Visual COBOL is a part of the Visual Studio 2010 product portfolio from Micro Focus which also
includes testing and developer productivity tools.

• COBOL Margins - visual indication of COBOL margins which are sensitive to the COBOL margin
directive currently selected for the program – if the setting is changed via an embedded "$SET
SOURCEFORMAT" directive, then the display is immediately updated.

• COBOL sensitivity is extended to support COBOL methods and data items in IntelliSense and
preconfigured "code snippets" reduce the effort required to complete code and avoid errors being
introduced.

• Background parsing continuously ensures that the code being worked on will compile cleanly.

COBOL 2010
Visual COBOL supports the development of both "managed" code which is fully interoperable with
other .NET languages and "native code". It is built on a new Micro Focus COBOL platform "COBOL 2010".

A standalone COBOL Server is available for deploying applications developed within Visual COBOL.

Visual COBOL provides a test license version of the COBOL Server to allow system testing before
deployment into production.

COBOL Language Extensions
Historically, COBOL has been case-insensitive which makes interoperation with .NET methods more
difficult than it should be. For example, method or member names had to be enclosed within quotation
marks and declare synonyms to refer to external types. With Visual COBOL these restrictions have been
removed and the code is more “.NET-like” while still retaining COBOL’s traditional ease of understanding.
Unnecessary COBOL elements such as “repository” have been made optional which greatly reduces the
size and complexity of a COBOL .NET program. The language changes improve readability and simplify
the learning process for existing C# or VB programmers who can easily work on the COBOL code. With
this flexibility, teams can be more agile and thus reduce development and maintenance costs.

Main Features of Visual COBOL 2.1 for Visual Studio 2012
This version of Visual COBOL includes the following main features:

Integration with Visual Studio 2012

Visual COBOL provides support for the new features of Visual Studio 2012 and the Visual Studio 2012
Integrated Shell, including:

Compatibility (Project
Round-Tripping)

The project round-tripping features enables you to use Visual Studio 2012 to
open and edit a project created with Visual Studio 2010 without upgrading or
changing anything. After closing the project, you can still open it in Visual
Studio 2010 to make further changes.

These are the requirements and the restrictions for using project round-
tripping with COBOL projects:
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Note:

• The version of Visual Studio 2010 being used to create and edit
projects must be Service Pack 1.

• For managed COBOL, the feature only works for applications that
target versions of the .NET Framework 2 to 4.

• There is a new format for COBOL SQL CLR projects in Visual
Studio 2012. Such projects created with Visual Studio 2010 will be
upgraded when you open them in Visual Studio 2012.

.NET Framework 4.5
Compatibility

Provides support for creating managed COBOL applications that target
version 4.5 of the .NET Framework.

Reference Manager Supports the new Add Reference dialog box which provides a faster way for
adding references to your projects.

Browse Code in Solution
Explorer Hub

Supports the enhanced Solution Explorer Hub without the in-built class/object
browser features.

Previewing Files in the
Code Editor

Supports code preview for COBOL files which enables you to explore the
files in your project without opening them in the editor.

Loading Projects
Asynchronously

Enables you to load your source code in the IDE and start working on it faster
even when you have large applications.

Search Supports the enhanced search features across the IDE for COBOL projects.

Visual Studio 2012
Themes

Visual COBOL conforms to the new look and feel of Visual Studio 2012.

Microsoft Help Viewer
2.0

Provides support for the Micro Focus Help in Microsoft Help Viewer 2.0.

New SQL CLR Project Templates

The COBOL SQL CLR project template has a new format. COBOL SQL CLR projects created with Visual
Studio 2010 will be upgraded when you open them in Visual Studio 2012.

Windows 8

Visual COBOL supports Windows 8.

Coexistence with Visual COBOL for Visual Studio 2010

Visual COBOL 2.1 for Visual Studio 2012 and Visual COBOL 2.1 for Visual Studio 2010 can coexist on the
same machine. You can use either one of these versions to edit COBOL projects that are supported by the
project round-tripping feature in Visual Studio 2012.

70 | What's New



Known Issues
Please refer to the Known Errors and Restrictions topic in the Product Information section of your product
Help.

In addition, please note the following:

ASP.NET

It is not possible to run ASP.NET Web Sites or Web Services on a production machine (one that has Micro
Focus COBOL Server installed) without an additional setup. This is because the production machine does
not contain development tools such as the COBOL Compiler. To workaround this, you need to do the
following steps:

1. Precompile the site before you deploy it using the Publish Web Site command in Visual Studio.
2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and delete the

Language="COBOL" statement.
3. Edit the Web.config file with a text editor and delete the line which contains: <compiler

language="COBOL"...

4. Ensure that a .NET Server license is installed using Apptrack.

COBOL Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement following the statement that
modifies the data on which that watchpoint is set.

Co-existing with Earlier Micro Focus Products

Run-time system
error due to
COBCONFIG

A run-time system error occurs if either the COBCONFIG or COBCONFIG_
environment variable is set when you run aVisual COBOL application or when you
use Visual COBOL to edit or create projects and the configuration file it refers to
contains entries that are not valid for Visual COBOL.

For example, this might happen if you have Net Express or Studio Enterprise Edition
installed and either COBCONFIG or COBCONFIG_ is set for it.

To work around this issue, ensure that Visual COBOL is not running and then modify
the configuration file by doing one of the following:

• If the invalid tunable is not needed by another application, remove it from the run-
time configuration file.

• Add the following as the first line in the configuration file:

set cobconfig_error_report=false

• Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that
does not contain the invalid tunable for the particular session you are running in.

Creating COBOL Projects from Selection

The documentation on creating COBOL projects from selection specifies that the newly created project has
the same properties and references as the original project. You should also note that the new project has
the default build configuration for the selected project type.
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Debugging

There is an issue with "Wait for attachment" when you use Visual COBOL for Eclipse to debug applications
that run on some Linux/Unix platforms. Eclipse connects to the debugger on the remote machine, but might
not attach to the process to debug the code.

To work around this issue, ensure that on the remote machine the TMPDIR environment variable is unset
or has the same value for both Micro Focus Visual COBOL Development Hub server and for the running
process you wish to debug. The Micro Focus Visual COBOL Development Hub server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or indirectly using the daemon
which is started with the $COBDIR/remotedev/startrdodaemon script.

To check the variable used by the Micro Focus Visual COBOL Development Hub server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as the one used by the
process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be changed in the
remote shell and must be set before you start the daemon or server.

Documentation

• In Visual Studio 2012, clicking Help > Micro Focus Product Help > Product Documentation results
in the message "Cannot find requested topic on your computer". If you see this message, click Micro
Focus Visual COBOL 2.1 Update 1 for Visual Studio 2012 in the Contents tab to display the
documentation as expected.

• If you install Visual COBOL for Visual Studio 2012 and its documentation is not available in the
Microsoft Help Viewer, perform the following steps:

1. In Visual Studio 2012, click Help > Add and Remove Help Content.
2. Choose the Manage Content tab.
3. Check the Disk radio button, then navigate to the folder containing the Visual COBOL for Visual

Studio 2012 documentation. By default, this is C:\Program Files (x86)\Micro Focus
\Visual COBOL for Visual Studio 2012\help.

4. Select helpcontentsetup.msha and click Open.
5. In the content list, click Add next to the Visual COBOL 2.1 entry.
6. Click Update.
7. Click Yes on the User Account Control and Microsoft Help Viewer 2.0 dialog boxes to enable the

update to continue.

The documentation for Visual COBOL for Visual Studio 2012 is added to the Microsoft Help Viewer.

Note:

This problem only occurs if you install Visual COBOL for Visual Studio 2012 while documentation
for Visual Studio 2012 is being downloaded or updated, which typically happens when you install
Visual Studio 2012 or run it for the first time.

File Handling

• When using a CGI/ISAPI application developed with the Net Express HTML Forms Designer in Visual
COBOL, you may receive an error “unresolved external symbol _NMCNVRTI” or “unresolved external
symbol _NMCNVRTO”.

To work around this issue, add the corresponding .obj file to the Additional Directives in the project
properties, or use them from the command line to link the application: cbllink filename.cbl
NMCNVRTI.OBJ (or cbllink filename.cbl NMCNVRTO.OBJ, respectively).
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• If you are accessing Vision files through the Vision file handler (as opposed to the default Micro Focus
File Handler) and you are upgrading from Visual COBOL version 2.0 to version 2.1, you must first
uninstall version 2.0, otherwise the Vision file handler may not function correctly.

Fileshare

A write of a record with an alternate key where the alternate key is the first value for that key may could
now return a 0/2 file status rather than a 0/0 status if a record with that alternate key value has been
deleted by uncommitted transaction (possibly the same transaction as that performing the write).

Installation

• A bug in 64-bit Windows 7 may cause the display of the Compatibility Assistant dialog box during the
installation of the product showing incorrectly that aslmpclocate.exe and init2aslm.exe are not
compatible. The two utilities run properly and the installation is successful. To avoid receiving this
notification, run Windows update and install update KB978637 before installing this product.

• If, when you start Visual Studio, you receive a message box about a Micro Focus package load failures,
check that the Packages folder is on the PATH environment variable. If it is not, click No to disable
loading the packages.

If you accidently click Yes, you need to re-enable loading the packages, as follows:

1. Open a Visual Studio command prompt from the Start menu.
2. Enter the command:

devenv /ResetSkipPkgs

3. Reboot the machine.

This should resolve the problem. The PATH is set up correctly and the packages are found.
• Installing this release as an upgrade to a previous version of the product might take longer compared to

installing the product for the first time.

Native COBOL

On Windows XP, when building a native COBOL application in Visual Studio, a dialog may pop up with
error "Unhandled exception at 0xc0006866 in cobol.exe: 0xC0000005: Access violation reading location
0xc0006866)". This is caused by Symantec antivirus runtime protection. To resolve this, you need to apply
the following fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Visual Studio IDE

• In your project properties, the Application page currently allows you to select any of the static methods
in the application as a Startup object. This is incorrect. You should always set only the first static
method or the program name as a Startup object in order for the project to build.

• In Visual Studio, the controls on the COBOL page in the project properties are not displayed for a WPF
project. To workaround this issue, open the Application page in the project properties and from the
drop-down list under Output type choose the same output type that was already selected. Close the
project property pages and save the project. The next time you open the project properties, the COBOL
page is properly displayed.

• When compiling a native COBOL application in Visual COBOL for Visual Studio which contains
resource files, you may receive compiler error "cannot open include file 'pshpack2.h'". To workaround
this problem, ensure you have the Windows SDK installed on your machine, add the include folder in
the Windows SDK installation (by default, %ProgramFiles%\Microsoft SDKs\Windows\v7.0A
\include on Windows 7) to your include path, and recompile. Note: The Windows SDK is available as
a free download from Microsoft's Web site.

Known Issues | 73

http://www.symantec.com/business/support/index?page=content&id=TECH97280&locale=en_US
http://www.symantec.com/business/support/index?page=content&id=TECH97280&locale=en_US


Visual Studio Shell

The following restrictions apply if you are using the Visual Studio Shell:

• On Windows XP, when building a managed COBOL application in Visual Studio, you may receive a
dialog box with error "The application failed to initialize properly (0xc0000005)". If you are running
Symantec antivirus runtime protection then this might be the cause for this issue. To resolve it, click
here to download a fix from Symantec.

• WCF is not supported so the WCF demonstration programs do not work and the project templates for
WCF are not installed.

• There is no integrated designer for icon and bitmap files.
• The Windows SDK must be installed.
• Examples and demonstration programs that use languages other than COBOL do not work because

Visual Studio Shell doesn't support any other languages. This applies to the following demonstrations:

• CursorDemo
• InterfacingWithStdCOBOL
• LobDemo
• OrderStatusDemo

74 | Known Issues

http://www.microfocus.com/docs/links.asp?nx=symerr
http://www.microfocus.com/docs/links.asp?nx=symerr


Resolved Issues
The resolved issues that customers have reported are listed in this section. The numbers that follow each
issue are the Reported Problem Incident number followed by the Customer Incident Numbers (in
parentheses). RPIs that have numbers only (and no text) are included to confirm that the RPIs have been
fixed, since no further information is required.

• .NET Compiler
• .NET ESQL Support
• .NET RTS
• Compiler
• Data Tools Converter
• Data Tools Vrecgen (Character)
• Documentation
• Eclipse IDE
• File Handling - External File Handler
• File Handling - Sort
• JVM - Debugger
• MF Communications Server
• MF Directory Server
• MVS REXX Emulation
• NCG
• RTS
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: OpenESQL
• Visual Studio IDE
• XML syntax support runtime

.NET Compiler

Back to List

• A COMPUTE statement where the target field had fewer significant digits than some of the operands of
the arithmetic expression no longer results in invalid arithmetic.

1087987 (2614566)

.NET ESQL Support

Back to List

• SQLWARN4 flag was not being set when more than one row was returned for a singleton SELECT
statement. The OpenESQL run-time now correctly sets SQLWARN flags when a singleton SELECT
statement returns multiple rows.

1085945 (2593798)
• The OpenESQL pre-compiler sometimes flagged object host variables as invalid when multiple

programs were compiled into a single .exe or a .dll file.

1086906 (2603712)
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.NET RTS

Back to List

• A performance issue with raising an expression to a fractional power has been fixed.

1086614 (2594740)

Compiler

Back to List

• Specify an environment variable with the USE and DIRECTIVES Compiler directives (e.g.
USE"$myDirs") to locate a directives file.

1086063 (2592063)

Data Tools Converter

Back to List

• The dfconv replacement input and output filenames are no longer truncated to the filename lengths
used within the profile file.

1086569 (2599741)

Data Tools Vrecgen (Character)

Back to List

• The source files for the VRECGEN and VRECGEN2 utilities are now stored in the .\src folder in the
product installation.

1087209 (2603963)

Documentation

Back to List

• The SSRANGE Compiler directive is provided for emulation of the IBM mainframe compiler of the same
name; because of this, its scope is limited to the syntax permissible in a mainframe dialect.

1087083 (2605408)
• To ensure no loss of functionality when accessing Vision and RM/COBOL data files, you should use the

appropriate IDXFORMAT Compiler directive setting or file handling option, and not use the
CALLFH(ACUFH) Compiler directive. See 'Configuring Access to Vision Files' and 'Configuring Access
to RM/COBOL Data Files' for more information.

593437 ( )
• All COBOL CICS programs that call user exits need to be compiled with the NOAMODE directive.

593780 ( )
• The documentation now clarifies the EZACICM.MOD location.

1086693 (2599949)
• The documentation now includes information about the -stcpssl cassub option.

1087060 (2605136)
• The documentation has been updated to provide more information about the MFJAMS LISTCAT

command.

594069 ( )
• The documentation has been updated to remove references to ERRORLEVEL in Unix environments.

1087575 (2610423)
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• The casrdtex documentation has been updated to include several more supported parameters.

594324 ( )

Eclipse IDE

Back to List

• You can now set program breakpoints as follows - click "Add Program Breakpoint" in the Run menu or
on the Breakpoints view toolbar, and enter the program name in the dialog that is displayed.

1087239 (2606838)
• When you download from a mainframe files that use DBCS characters, any shift-out and shift-in control

characters should be kept in the downloaded source code. When entering new DBCS characters in the
COBOL Editor, shift-out and shift-in control characters must be added manually using the following key
combinations: for shift-out press Alt+S, release them and then press O; for shift-in press Alt+S, release
them and then press I. These key combinations can be altered using the Eclipse Preferences dialog
box.

594093 ( )
• When building within Eclipse, the COBCPY environment variable value set before launching Eclipse

was truncated to a maximum of 1024 characters.

1087408 (2608978)
• Eclipse could stop responding or use excessive amounts of memory when large COBOL JVM projects

were opened.

1087777 (2610488)
• Eclipse could stop responding or use excessive amounts of memory when building large projects.

1087748 (2610469)
• A problem with Variables view not allowing you to modify the values of string variables in EBCDIC

projects has been resolved. In addition, the Change Value dialog now displays correctly the values of
the variables in HEX mode.

593497 ( )
• Variables which were only used in preprocessed source lines were marked as not referenced.

1087030 (2603385)
• Remote ports that were previously set are preserved when a launch configuration is reopened.

1086008 (2594159)

File Handling - External File Handler

Back to List

• EXTFH configuration options specified under the FOLDER tag now work correctly with UNIX files when
they are specified with an absolute path in the SELECT statement of a COBOL program.

1086089 (2594733)
• RMFM record lock timeouts now work correctly on UNIX.

1087015 (2602108)

File Handling - Sort

Back to List

• A SORT RETURN statement now returns a 9/230 error for the return past EOF.

1087358 (2606867)
• SORT now terminates with return code 16 and throws a 9/013 error when the catalogued input file is

not physically present.
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1087529 (2607690)
• SORT now terminates with return code 16 and displays error message "SORT103E Invalid

operator .JOINKEYS." when the JCL contains the JOINKEYS parameter.

1087311 (2607369)

JVM - Debugger

Back to List

• The JVM COBOL Debugger could only locate copybooks that were located in the same directory as the
COBOL program.

1086348 (2597430)

MVS REXX Emulation

Back to List

• Execs residing in temporary datasets allocated to SYSEXEC or SYSPROC no longer sometimes fail to
load.

1086478 (2579785)
• The bpxwunix() function is now supported by the REXX engine.

1085190 (2584045)

NCG

Back to List

• An error when linking on Solaris Intel 64 bit with the latest versions of Solaris 10 has been fixed.

1086852 (2602536)
• Display statements of the type "display a(1:i*c) at 0101" could cause the generator to fail when in debug

mode.

1088048 (2607368)

Setup Issues (UNIX)

Back to List

• During installation, the CheckDiskSpace function no longer relies on English text strings from the UNIX
df command.

1086610 (2600117)

SQL: COBSQL

Back to List

• The COBSQL preprocessor could not process options longer than 65 characters.

1085597 (2589416)

SQL: OpenESQL

Back to List

• The SQL JVM Run-Time .jar library file is now supplied as part of the Micro Focus COBOL deployment
products for UNIX.

1087595 (2610662)
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• The OpenESQL preprocessor sometimes generated incorrect query lengths for EXEC SQL PREPARE
INTO FROM statements, resulting in the SQL queries being truncated.

1087324 (2607761)
• The ODBC pre-compiler now allows you to define host variables after the DECLARE CURSOR SQL

statement if they are not defined in the PROCEDURE DIVISION.

1086501 (2599123)
• When using the SQL Server Native Client ODBC driver, the OpenESQL Run-Time System now

correctly processes SQL Server data defined as VARCHAR(MAX).

1086665 (2601192)

Visual Studio IDE

Back to List

• The Error List window now shows the details about the "Illegal command line" error when it is a result of
setting invalid SQL directives.

1085251 (2585426)
• When you debug native code and query a data item which contains null bytes, the value displayed in

the Watch window is no longer truncated at the first null byte.

1087235 (2604749)
• Adding files to a project when directives scan is disabled was taking a long time to complete.

593378 ( )
• An issue where you could not open copybooks from the context menu in the COBOL editor when the

filename was specified with its extension and without surrounding quotes has been resolved.

1087031 (2604709)
• There is an improvement in the performance of the cursor in the text editor when working with larger

files and projects.

1085255 (2585450)
• A problem with the value of "Link with objs" setting being duplicated after you reload the COBOL Link

properties page has been resolved.

1086091 (2595408)
• Previously, when you upgraded COBOL projects with signed assemblies from Visual Studio 2003

format to Visual Studio 2010 format, the signed assembly property was lost.

1085258 (2585458)
• There is no longer a crash when adding a reference path to a managed COBOL project.

1087055 (2604844)

XML syntax support runtime

Back to List

• The XML preprocessor now generates correct output for the COUNT IN clause.

1086285 (2596137)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2013. All rights reserved.
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